Retell a Poem
Frames - Digital Storytelling

Recipes4Success®

In this Recipe, you will learn how to use Frames to retell a poem. You will import a
folder of images, add text, text effects, music, and transitions, and then export the
poem as a movie.
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Introduction

In this Recipe, you will create a movie that retells a poem by William Carlos Williams.
so much depends
upon
a red wheel
barrow
glazed with rain
water
beside the white
chickens

Open Frames.

Click the Start button.

Choose All Programs, choose the Tech4Learning folder, choose the Frames folder,
and select Frames.

Frames will open.
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Add a Folder of Images

When Frames opens, you will see an empty animation. You need to add frames to the
animation to begin.

In this tutorial, you will add sample images from the Library.

If you have taken your own pictures with a digital camera or drawn them in program like

Pixie or Twist, you can add them using the Add Images from a Folder button in the
Preview area.
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This animation is empty.

B = @k

lUse the buttans above to add files, or drag files over this
win o,

Click the Library tab.

L options  ESIEENNG

You will see the folders in the Library.
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Double-click the Tutorial folder to open it.

Click the Storytelling folder to select it.
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R

Storytelling

Click and drag this folder into the Preview area.

You will see the cursor change to show that you are adding the frames in this folder.

[+]J5 e

this wirncd o

-

This animation is empty. =

LIse the buttons abowve to add files, or drag files ower

Let go of the mouse button.
You will see each frame in the Frame List.

You will also see the last frame in the Preview area.
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Curibmn: 2.0 seconds

If you see the Storyboard, click the Frame List tab.

[

Frame List

wow _wheelbarr. ..

Preview the Animation

You can preview the animation.

..“.U
My

wow _wheelbarr...
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The timeline is currently set to the last frame.

Click the First Frame button in the Preview area.
- - Pl
le '.. |fh-;~"| I'xH;]
N g | N
Click the Play button in the Preview area to watch the animation.
Fal = = Failis
) E‘d}l @ {hh} \ )
The animation will end at the last frame.

Copy and Paste a Frame
You can copy and paste frames.

Click the first frame in the list.

- Framelst (I

. wiw_wheelbarrowi2
: -] wow_wheelbarrowi3
o) | wiow_wheelbarrowid

Click the Copy button on the toolbar.
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Copy

Click the Paste button on the toolbar.

C

Paste

A copy of the first frame will be pasted after the first frame.

- Framelst [

E wiw_wheelbarrowil
E wiow_wheelbarrowi2
E wow_wheelbarrow03
ﬂ wow_wheelbarrowid

Change Frame Duration
You can change the length of time a frame is shown.

Click the first frame of the animation.
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: wiw_wheelbarrowil
£ ] wow_wheelbarrown2
-] wow_wheelbarrowis
: -] wow_wheelbarrowid

Click the Options tab to see the editing options for the frame.

x
i - B
You will see the duration for the first frame.
¥ ™

El | | _hoose File |

apply to All Frames |

Duration: 0.5 & seconds

Click and drag the Duration slider to the right to make this frame last 2 seconds.

Duration: 2 = | seconds

£
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You can change the duration on more than one frame at a time.

Click the second frame.

- wow_wheelbarrowi1
: ow_wheelbarrowilz
e wow_wheelbarrowns
E wiw_wheelbarrowig

Press and hold the Shift key on the keyboard.

Click the last frame in the animation. This will select all these two frames and all the
frames between them.

| wow_wheelbarrowil

Click and drag the Duration slider to the right to make each frame show for 4 seconds.

Durakion: 4 & | seconds

IS
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Save the Animation

You should save the Frames file as you work on it

Click the Save button on the toolbar.

=

Save

You will see the Save Animation As dialog.

fl Save Animation As

Sawe in: :jMyDncummts

- ) My Music
\_\;9 I3y My Pictures

™ py videos

'E <
Fil= name:

|
My Netwaork '

Places Files of type: 4l Files
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Type a nhame for the animation in the File name field.

Use the Save in pull-down menu to choose the place you want to save the file.

ki Save Animation As

savein: | ™ py videos v 2 EE

(=4 Finn. avi
\_\_b (=) Lab Safety,asx

My Recent (=3 Plant.ay1
Documents 23] Spectacled Bear AV

38
My Compauter

;‘3 Fil= name: williams Posm

My hetwork y
Places Files of bype! | all Files v

EH

Click the Save button.

The animation will be saved.

Add a Text Object

You can add text so the viewer can read the lines of the poem.

Click the second frame in the Frame List.
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-l wow_wheelbarrowii

---%cw_wheelbarmwﬂz

E wow _wheelbarrowi3
' E wow_wheelbarrowDd

Click the Text button on the toolbar.

T

Text

You will see a text object in the middle of the frame.

E'IZITJ |:l-| l'-_'-. l::Ti l::-k E -
to add text

L

-

I
-

Double-click the text object.

You will see a blinking cursor.

Type: so much depends

Press the Enter key on the keyboard.

Type: upon
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Izo much depends,
Lpo n]

Click the frame outside of the text object when you are done.

The text object will no longer be selected.

g0 much depends
upaon

Format Text
You can change the way text looks.

Click the text object to select it again.

1o much depends,

upon h
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Move the cursor over a corner handle.

It will change to two arrows.

o0 much depends,

L] FI on L}
1
]

Click and drag the corner handles away from the center of the text object until it takes
up most of the sky in the picture.

so much depends
upon

Click the Left Alignment button on the Options panel to change the alignment.
Alignment: %

Click the Font pull-down menu on the Options panel to choose a new font.
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Fank: |Aharaoni

sana Mlew

Size:

sanalTRC

Click and drag the Size slider on the Options panel to make the font larger.

Size! %

56 pt

The preview will change as you drag the slider.

Click the Fill color box to choose a new text color.

Fil: [ ]

You will see a color palette.
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Fill: |:| Choose File |

L]

Raka

[]4
| black (20, 10} |

Click the color you want for the text.

Click the gray area around the preview when you are done.
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Copy and Paste a Text Object
You can copy and paste a text object from one frame to another.

Click the text object to select it.
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Click the Copy button on the toolbar.

N

Copy

Click the next frame in the Frame List.

-t wow_wheelbarrow01
Eli wiw_wheelbarrowil

- s0 much depe. .,

ow_wheelbarrowl3

- wow_wheelbarrowi4

Click the Paste button on the toolbar.

C

Paste
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You will see the text object on this frame.

Double-click the text object.
You will see a blinking cursor.

Click behind the last letter of the second line and drag to the left of the first letter of the
first line to select all of the text.

upon

Type: a red wheel
Press the Enter key on the keyboard.

Type: barrow
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Click the next frame in the Frame List.

- wow_wheelbarrowi 1
EIE wiw_wheelbarrow0l
E ----- wiow_wheelbarrowi 1
: - so much depe. ..
EIE wow_wheelbarrow0z
E ----- wiw_wheelbarrowl2

- a red wheelbarrow

Click the Paste button on the

ow_wheelbarrow0d

toolbar.
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C

Paste

Double-click the text object and select all the text.
Type: glazed with rain
Press the Enter key on the keyboard.

Type: water

Click the next frame in the Frame List.
Click the Paste button on the toolbar.
Double-click the text object and select all the text.

Type: beside the white
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Press the Enter key on the keyboard.

Type: chickens

Add a New Frame
You can add more frames to an animation such as a frame for a title.

Click the New Blank Frame button at the bottom of the Frame List.

E duckn?
E duckln

[E

L
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You will see a new frame at the end of the list.

BN storyboard

- wow_wheelbarrowi 1

EIE wiw_wheelbarrow0l

: > ----- wow _wheelbarrowdl Image

; - =0 much dependsupon

-] wow_wheelbarrown2

: ----- wiw_wheelbarrowl2 Image

_ - a red wheelbarrow

EIE wiw_wheelbarrow03

: > ----- wow _wheelbarrowd3 Image

; - glazed with raimaater

-] wow_wheelbarrown4

: ----- wiw_wheelbarrowl4 Image
- beside the whitechickens

Click the Text button on the toolbar.

T

Text

You will see a text object in the middle of the frame.

Use the skills you have learned to add and format text that says:

a poem by:

William Carlos Williams
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a poem by
William Carlos Williams

Click the Save button on the toolbar.

=

Save

Click the First Frame button in the Preview area.

NN TN N D
() ( ) (pr) )

s

Click the Play button to see a preview of the movie.
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B

Add a Text Effect

You can add effects to your text.

Click the Text Effect button on the toolbar.

yo!

Texk Effect

You will see the text effect options in the Options panel.
Click Scroll in the Effect list.
Use the Options pull-down menu to choose Up.

Use the up Duration arrow to change the duration to 2 seconds.
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- Options [T

-

Click the Apply button.

Effect:

Cpkions:

Curakion:

Preview:

Text Effects
Galaxy s
LeafBlower
Shaker
Spin W

T

i

You will see this Warning message telling you that the text cannot be edited after the

text effect is run.
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w4 Warning

longer be able to edit text and ohjectz on the zelected frames.

',T The effect vou are adding changes the zelected framesz. You will no
L

Cancel |

Click the OK button.
Frames will render the frames needed for the text effect.
You will see the frame turn into a group in the Frame List.

Click the plus symbol next to the group to see all of the frames.

s

Click the last frame in the group.

- Scroll Up 46 Frame
E Scroll Up 47 Frame

EEE

Change the duration on this last frame to 4 seconds.
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Durakion: 4 & | seconds

i

Add a Transition
You can add transitions between frames.
Transitions are added after the selected frame.

Click the first frame in the Frame List to add a transition between frames one and two.

- Framelst [

EI ow_wheelbarrowidl

o so much dependsupo

Click the Transition button on the toolbar.

¥

Transition

You will see the transition options in the Options panel.
Select Blend from the Transition list.

Leave the Duration set to 1 second.
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-

Transitions

Transition: Bars ~

Cptions: Mone

Duration: 1%

Background: ||

FPreview:

Click the Apply button.
You will see the transition frames being processed.

You will see the transition in the Frame List.

- wow_wheelbarrowi1

EIE wiow_wheelbarrowl

Recipes4Success www.recipes4success.com ©2006 Tech4Learning, Inc.



Retell a Poem Page 33 of 40
Frames - Digital Storytelling

Add this same transition between each of the frames in the animation.

When you are finished, a collapsed Frame List will look like this:

| Framelst [

- wow_wheelbarrowil
El Blend Transition Group

- wow_wheelbarrowi

E Blend Transition Group

E wow _wheelbarrowdz2
El Blend Transition Group
E wiow_wheelbarrowi3
El Blend Transition Group
ﬂ wow_wheelbarrowid
E Blend Transition Group

El Scroll Up Group

Add Sound

You can add sound to an animation.

Click the First Frame button in the Preview area to have the sound start at the
beginning of the animation.

@?‘\;;-ﬁ [ .:E| ii_l:ii:]

Click the Library tab.
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L options  ESSIEENES

Click the Home button.

Double-click the Sounds folder.

i
Sounds

Double-click the Music folder.
Mu=ic
Find and click the Lost in You sound.

@) »
Ol

Lost in “ou

You will see buttons on the sound.
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Click the Add button.

O

Lozt in Yo

The sound will be added to the animation starting at the first frame.

Lozt_in_You

D4 V 4

Click the Save button on the toolbar to save the changes you have made.

=

Save
Click the First Frame button in the Preview area.

N 7
OCICICIC

Click the Play button to see a preview of the animation.
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B

Make a Movie
You can export the animation as a movie file you can share with other people.

Click the Make button on the toolbar.

<

Make

You will see the Export Animation dialog.

Click the Presentation radio button.
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Export Animation

Export animation far:

() Podcast
320240 MOY Mavie

) Wweb

F20x240 MOY Mowvie

B0x430 AYI

(7 Full Guality
Actual Project Size AYI

() Animated Gif

fctual Project Size Animated Gif

| Expert Settings | Cancel || Export

Click the Export button.

You will see the Save As dialog.
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Lookin: | () My Documents

v| 2 @
_ ) My Music
(A E} [y My Pictures
My Recent P8 My videos
Documents
Deskiop

@« =
_‘)! Fil= name:
Iy Metwork

Places Files of bvpe:

Williams Posm

All Fles

Use the Save in pull-down menu to choose a place to save the file.

The name of the Frames file is already in the File name field.
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Lookin: | P pay videos v ¥ EE

(=3 Finn.avi
‘_3.% (=) Lab Safety,asx

My Recent (=3 Plant. a1
Documents 2] Spectacled Bear AV

|_ﬂ§ E Williams Poem, fra

Iy Compauter

‘:3 Fil= name: williams Posm

My Metwork,

|
Places Files of type: | all Eles |

Click the Save button.
Frames will create the movie.

When it is finished, you will see a Finished Exporting dialog.

kd Finished Exporting

1 ) Your animation has finizhed exporting! Click the Launch button to views

the exported animation.

Launch |
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Click the Launch button to watch your movie.

Conclusion

Go to the File menu and choose Exit.
Congratulations! You have created an animated movie using Frames.
In this Recipe, you learned how to:
Open Frames

Add a folder of images

Copy and paste a frame

Preview an animation

Save an animation

Add a blank frame

Add text

Format text

Add text effects

Add transitions

Add sound

Make a movie
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